# MSDTool: Requirements Document

Sonal Gupta, Joshua Shaffer, David Turner and Mark Zuber  
{sg385, jbs36, dmt36, mrz23}@drexel.edu

February 9, 2007

## Contents

1 Introduction ................................................. 4  
1.1 Background ........................................... 4  
1.2 Goals .................................................. 5  
1.3 Data Ingress .......................................... 5  
1.3.1 Orientation Imaging Microscopy (OIM) ............... 6  
1.3.2 Raman Spectroscopy ................................ 6  
1.3.3 Nano-indentation (Nano) ........................... 6  

2 Functional Requirements .................................. 6  
2.1 Input Formats .......................................... 7  
2.1.1 Fourier Coefficients ............................... 7  
2.1.2 Formats Equivalent to Fourier Coefficients .......... 7  
2.1.3 Formats Equivalent to Fourier Coefficients Interface . 7  
2.2 Overall Functionality ................................... 7  
2.3 Core Algorithms ........................................ 7  
2.3.1 Forward Processing (Analysis) ..................... 8  
2.3.2 Reverse Processing (Synthesis) ..................... 9  
2.4 GUI ................................................... 9  
2.4.1 Login ............................................. 9  
2.4.2 Main Window ...................................... 12  
2.4.3 Pole Figure Viewer Window ....................... 13  
2.4.4 Select Sample Window ............................. 15  
2.4.5 Edit Sample Window ............................. 15  
2.4.6 Add Sample Window ............................... 15  
2.4.7 Select Point Set Window ......................... 15  
2.4.8 Edit Point Set Window ........................... 15  
2.4.9 Add Point Set Window ........................... 16  
2.4.10 Non Logged-in Mode Menus ..................... 30  
2.4.11 Logged-in Mode Menus ........................... 30  
2.5 Database ............................................. 31
2.5.1 Database Personas ......................................................... 31
2.5.2 Material Closures ......................................................... 31

3 Non-Functional Requirements 31
3.1 Documentation ............................................................... 31
  3.1.1 User Manual .............................................................. 31
  3.1.2 Design Document ....................................................... 31
  3.1.3 API Reference .......................................................... 32
  3.1.4 Maintainability .......................................................... 32
3.2 Minimal Hardware Recommendations ................................. 32
3.3 Software Platform .......................................................... 32
3.4 Decoupling Algorithms from Problems ............................... 32
  3.4.1 Unit Tests for Algorithms ............................................ 32
3.5 Run-time Speed and Expectations ..................................... 32
3.6 Network Interoperability .................................................. 32
  3.6.1 Properties Framework ............................................... 33
  3.6.2 Closures ................................................................. 33
  3.6.3 Interactive .............................................................. 33
3.7 System Administration Requirements ................................. 33
  3.7.1 Authentication .......................................................... 33
  3.7.2 Adding Users .......................................................... 33
  3.7.3 Groups of Users ....................................................... 33
  3.7.4 Deleting Users .......................................................... 33
  3.7.5 Logging and Auditing ............................................... 33

4 Glossary ............................................................ 34

5 Index ............................................................. 35

List of Tables

List of Figures

1 Summary Image ............................................................. 4
2 A flow chart modeling the overall intended functionality of the MSD Tool application. .... 8
3 Login Window ............................................................... 10
4 Login: DNS Error .......................................................... 10
5 Login: Server Error .......................................................... 11
6 Main Window ................................................................. 13
7 Pole Figure ................................................................. 14
8 File Menu ................................................................. 16
9 Edit Sample Window ......................................................... 17
10 Edit Point Window .......................................................... 18
11 Add Point Window .......................................................... 19
12 Add Sample Window ......................................................... 20
13 File-Import Menu ............................................................ 21
1 Introduction

MSDTool is a computer aided engineering (CAE) framework and application for materials science and engineering. The application aids material designers in answering quantitative problems commonly posed while investigating new materials that formerly were done with individual programs and spreadsheets. This application is supported by an extensible framework of algorithms that derive values of physical properties from descriptions of microstructure.

1.1 Background

![Microstructure Hull and Property Closure Diagram](image1)

The Mechanics of Microstructure (MMG) group at Drexel University along with collaborators at Brigham Young University (BYU) have developed a corpus of techniques for aiding engineers in the process of Microstructure Sensitive Design (MSD). MSD, a term coined by these researchers, is a new material design paradigm that provides a link between descriptions of material microstructures and their corresponding physical properties. Additionally, mathematical techniques are currently being researched which will model the effects that manufacturing processes have on microstructure and their properties. The MMG’s research has produced a number of such MSD techniques for particular material classes and properties of interest. The rigorous mathematical framework and the theory on which these techniques are based is complex and beyond the scope of this document. However, a short discussion of key concepts and terms is absolutely vital to understanding the functionality and value of MSDTool.

The MMG’s work has lead to the development of two key concepts within the MSD paradigm, the microstructure hull and the property closure. The microstructure hull is the set of all possible microstructures that are relevant to a design problem (based on the governing physics). From this hull, a property closure can be derived. The closure is a description of all physically realizable values for a property set of interest. The property closure is particularly useful to material designers because it provides a map of where they are at least theoretically able to go in terms of the space of properties. This view becomes even more useful when one can use modern microstructure analysis equipment to examine a sample material and find out where it lies in the closure space.
The MSD techniques that MSDTool is primarily concerned with are of three classes; (a) algorithms which take as input a microstructure description (e.g. crystallographic orientation) and compute material properties (e.g. Elastic Stiffness), (b) methods for computing closures for a given sets of properties, (c) and rendering algorithms for visualizations of microstructures. The MMG has implemented many such techniques and it continues to develop new ones. Many of the techniques for computing closures require solving quadratic programming optimization problems. These closure computations require a considerable amount of computation time.

### 1.2 Goals

In general, MSDTool aims to provide three central resources for the MMG and designers of custom materials. First, an application that allows for the visualization of property closures for materials. Additionally, the effective property ranges of sample materials may be plotted within these closures. Second, a framework that allows researchers to add new algorithms (i.e. property calculators) to the application that support a new property. Third, a back-end database which stores atlases of material closures. These closures will be computed continuously as new algorithms are added to the framework and will be stored on the database server.

1. GUI Application

   Given the ad-hoc nature of the existing software tools, a user interface for a given unit of the toolchain behaves inconsistently and unintuitively. Solving this problem requires direct application of (1) software engineering techniques that permit new tools to coexist with current tools, and (2) coherent visual communication mechanisms to manage it. Moreover, certain aspects of the algorithms directly lend themselves to graphical modalities of interaction.

2. Software Integration

   The MMG’s current technique tool chain consists of a loose set of software modules that the MMG developed in a wide range of computer languages (i.e., Matlab, Fortran, C and Visual Basic). This poses a direct challenge to both automation, and as a consequence, commercial viability. Nevertheless, the system, outlined in the following sections, solves this problem.

3. Database

   The computation of property closures in many cases is computationally expensive. The MMG group spends a great deal of research computing time calculating these closures only to store them in text files across a wide array of workstations in their lab. They have expressed a desire to begin computing and storing these closures in a more efficient manner. This ”atlas” will have high commercial value.

### 1.3 Data Ingress

There are numerous sources of data that we synchronize and format before their use and apply mathematical models developed by the MMG. These data sources range from both commercial and in house
microstructure analysis tools. In addition, there is a database of physical constants and other needed precomputed parameters (i.e. stiffness tensor coefficients). Users import insertions into the application upon the collection of new measurement data. The following sections detail the aforementioned data.

1.3.1 Orientation Imaging Microscopy (OIM)

Orientation Imaging Microscopy (OIM) is a commercial technique; it measures the crystallographic orientation of a sample material. OIM involves scanning a across a sample in a regular grid and at each point, performing a technique called Electron Backscatter Diffraction (EBSD). The diffraction patterns produced at each point are heavily processed and the orientation parameters are extracted if possible. The MMG group uses a commercial application to perform OIM. The user may export this data from the commercial application in a simple ASCII text representation containing a set of Euler angles as floating point numbers for each grid point. These Euler angles represent the crystallographic orientation.

1.3.2 Raman Spectroscopy

Raman Spectroscopy obtains the chemical composition of a material by X-Ray diffraction. The vibrational information gathered from a sample material serves as a sort of fingerprint for molecular structure of the material. The MMG uses another commercial application to gather this information in the form a set of spectra. The format is a set of tuples of floating point numbers.

1.3.3 Nano-indentation (Nano)

The MMG also uses Nano-Indentation. This technique involves using a special machine to depress an indenter of known geometry into a material. The machine applies more load onto the material as it pushes the tip deeper into the material, and records the area deformed in this process. The MMG group uses a commercial tool to run the nano-indenteter machine and record the load vs. displacement data. In addition, this application derives many mechanical properties of the material. However, the MMG have decided against using these derived properties because of concerns about the methods used in their calculation, particularly, and from whence came the assumptions. Instead, they have opted to simply import the raw data from the software and calculate the properties using their own methods.

2 Functional Requirements

The central goal of the project creates an application to aid designers in the creation of custom materials. Designers conduct materials design over the property space of interest. MSDTool allows users to explore this property space chiefly in the form of a 2D closure. In addition to this primary visualization, the application GUI will provide a number of other useful visualizations that the MMG have requested. This application will also support all administrative actions on the database that contains pre-calculated closures, user account information, code points for property calculation algorithms, and other miscellaneous physical constants. In essence, this client application will be the core functionality of the entire MSDTool system.
The following section can be broken down into several subsections. The mathematical methods used to calculate these properties are given a brief overview in the Core Algorithms section. These algorithms are chiefly the result of prior and ongoing research of the MMG. Finally, we present a detailed description of the exact functionality of the application through its GUI.

2.1 Input Formats

2.1.1 Fourier Coefficients

The system allows an authorized user to add a new collection of Fourier coefficients (e.g., “Databases” in MSD terminology).

2.1.2 Formats Equivalent to Fourier Coefficients

The system allows an authorized user to add a new collection of non-Fourier coefficients provided that they can be converted to a Fourier series.

2.1.3 Formats Equivalent to Fourier Coefficients Interface

The system allows a developer to add methods of converting a stream on non-Fourier coefficients into Fourier coefficients through MSDTool’s application interface.

2.2 Overall Functionality

The above figure gives the general flow of the application from a functionality perspective. The user imports the data from three microstructural analysis techniques. Then, the user generates a report from the data to obtain one large volume of uniform data. From this, the user graphically views the different properties. These properties come from different mathematical models. One point statistics approximates the distribution of properties throughout the material. The two point statistics provides a more accurate view of the material properties; however, its mathematical model cannot describe certain details that one point manifests.

We may choose properties from user defined materials or from the database which contains the single crystal elastic constants to generate the boundary of the closure.

Within the closure the user may select the start and end point for a process path. The application then calculates a possible optimal path along the two points. The process takes into consideration whether a particular path physically exists.

2.3 Core Algorithms

The set of algorithms used in MSDTool fall into two equivalence classes: (1) extracting properties from the current set of physically realizable properties through experimentation (i.e., Forward Processing);
and generating “recipes” for producing a new material with a needed set of properties from the set of existing physical realizable materials.

2.3.1 Forward Processing (Analysis)

MSDTool supports the ability to calculate properties of existing materials. These data define points in a high-dimensional space that represents the set of properties a given material has.

Adding new materials to the database of existing materials is the providence of either (1) the system
administrator or (2) a privileged user.

2.3.2 Reverse Processing (Synthesis)

Reverse Processing constitutes the ability to synthesize new materials from existing materials. A convex-hull consisting of the physically realizable possibilities

2.4 GUI

2.4.1 Login

In order for a user to access any of the functionality of the MSDTool application they need to first login. This login process is necessary to connect to the database of material closures. Without access to this database, there is really no functionality that MSDTool can support. This is why logging in is a requirement for application use.

The login window (Figure 3) will be presented to a user upon application startup or by accessing it from the File menu. The window is identical to the standard login process requiring the user to specify their user name and password. In addition, the database server address must be entered. A history of these servers will be remembered from previous login attempts. If the user wishes to specify a new database server they may click the new item in the drop down and type the address. If the database login is successful then the main application window will become active and the user may begin using MSDTool. However, at least two connectivity errors may occur. First, the server name may not be resolved by the domain’s DNS, this leads to an unknown server error (Figure 4). Second, the server may not accept the login for a number of reasons such as incorrect user name or password (Figure 5).
Figure 3: Login Window

Figure 4: Login: DNS Error
Figure 5: Login: Server Error
2.4.2 Main Window

MSDTool’s main window (Figure 6) becomes active after a successful user login. It is from here that the rest of the application functionality may be accessed. The center of the window contains the main view of the current closure that the user is analyzing. This 2D plot is a closure on two specific scalar properties of interest. Along the vertical and horizontal axes of this closure the user may select these two properties of interest. The two property drop-down boxes contain the same list of property names (e.g. components of the elastic stiffness tensor; C1111, C2222, etc.) These drop downs allow quick changes of the closure. The contents of these lists is only a subset of the total available properties. This subset can be selected by opening the property chooser menu by hitting the more item. The property selector provides a hierarchical view of all available properties and allows the user to select which ones will appear in the drop down menus for quick access. If the user wishes to change other details about the closure they may click the large edit button on the bottom right of the display. This window allows the same property selection process in addition to other important details such as material type.

Other functionality of the MSDTool application is provided through the main window. Interaction with the graph via left and right mouse clicks presents other functions. One key function is the ability to add sample data from real materials and plot their effective property ranges within the closure. This feature may be accessed via a right click context menu on the graph or through the Database Menu (Section 2.4.11). Clicking Add Sample from the context menu will open the Add Sample Window (Section 2.4.6). Editing a sample (Section 2.4.5) may be accessed by right clicking the sample box and clicking edit sample. Samples may be removed from the graph as well from this menu.

The final item in the right click context menu of the closure graph is the view sub-menu. This menu provides access to all additional views that can be associated with a given point or sample in the closure. These views can enable the user to see details of the underlying microstructure that manifests these property values. One such view is the Pole Figure Viewer Window (Section 2.4.2). The MMG has a number of views they would like to support but the details of these have not been described to date. We will assume these views are extra features that will not effect the acceptance functionality of MSDTool. The remaining application functionality can be accessed from the Main Menu (Section 2.4.11).
2.4.3 Pole Figure Viewer Window

Since materials research deals with the visualization of tiny crystalline structures that make up the material, alternative visualizations are needed to get a grasp on the position and orientation of these crystals. MSDTool allows visualization of these structures through the use of 2D/3D graphs called pole figures. Pole figures are basically graphs that represent the distribution of the orientations of the crystalline structures.

MSDTool allows the visualization of single and multiple sample/point set data in a Pole Figure Viewer Window (Figure 7). Pole figures can be viewed in both 3D and flattened to be viewed in 2D. The Pole Figure Viewer Window allows the user to manipulate the figure in multiple ways. The user can use
the graph type drop-down to either view the figure as a contour map or as each point separately in 3D space. The axis drop-down represents the view vector that from which the actually figure is generated so different axes produce different pole figures depending on the symmetry of the underlying crystals. The Graph Type drop-down can be used to view the pole figure in different ways (e.g. stereographic or equal angle). The Draw Flat check-box can be used to make the 3D pole figure 2D or vice versa. The Camera Control drop-down allows the user to specify their mouse control (Track-Ball, Rotate, and Zoom). The Frame Controls change the actual look of the pole figure rather than effecting the underlying data. You can change the color gradients and remove contour lines with the Palette Frame and Smooth Palette check-boxes. Finally, the Transparency scrollbar changes the pole figure from opaque to completely transparent. When multiple pole figures are viewed simultaneously they will be viewed as intersecting planes in 3D and the Draw Flat option will be disabled.

Figure 7: Pole Figure
2.4.4 Select Sample Window

The Select Sample Window (Figure 9) allows users to select a particular available sample for editing. The window consists of a list of available samples describing them by their label, the lab that created them, the data they were modified, and the property list that is tied to them.

2.4.5 Edit Sample Window

The Edit Sample Window (Figure 9) lets users change information about a selected sample. There are three tabs in the edit sample window that correspond to the three different parts of the sample you can edit. From left to right they are the Information tab, the Data tab, and the Permissions tab.

The Information tab allows users to tag the sample. The user can enter a label for the sample, the source of where it came from (e.g. the high level point set of where the sample is from), and a description about the sample so the user can store any special reminder information they would need for future use of the sample.

The Data tab allows the user to change the underlying data file the sample is tied to. The user can browse either the local disk or the server for another data file (Fourier Coefficients or Euler Angles) to bind to the sample.

The Permission tab allows the user to set UNIX like permissions on the file so it can be restricted both locally and on the database.

2.4.6 Add Sample Window

The Add Sample Window (Figure 12) allows the user to insert a sample into the current pool of available samples. The new sample is specified in the same matter as in the Edit Sample Window (Figure 9).

2.4.7 Select Point Set Window

The Select Point Set Window (Figure 10) is identical to the Select Sample Window (Figure 9) in functionality. The only difference is that the list box contains available point sets instead of samples.

2.4.8 Edit Point Set Window

The Edit Point Set Window (Figure 10) allows users to select a particular available point set for editing. The first three tabs are identical to the Edit Point Set Window (Figure 9). The only difference is that different properties can be binded to a point set, this gives rise to the properties tab.

The Properties tab allows users to pick specific properties to bind to the data points, these properties can then be selected later when the user views the point set in the graphs. The users can select a particular property type and then when the OK button is pressed all the properties under that type will be added to the available pool.
2.4.9 Add Point Set Window

The Add Point Set Window (Figure 11) allows the user to insert a point set into the current pool of available point sets. The new point set is specified in the same matter as in the Edit Point Set Window (Figure 10).

Figure 8: File Menu
Figure 9: Edit Sample Window
Figure 10: Edit Point Window
Figure 11: Add Point Window
Figure 12: Add Sample Window
Figure 13: File-Import Menu
<table>
<thead>
<tr>
<th>Export</th>
<th>Personal Material Database (XML)</th>
<th>Closure Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Visualization Image</td>
<td>Window 1</td>
</tr>
<tr>
<td>Print</td>
<td>Closure Plot</td>
<td>Window 2</td>
</tr>
<tr>
<td></td>
<td>Window 1</td>
<td>Window 3</td>
</tr>
<tr>
<td></td>
<td>Window 2</td>
<td>Window 4</td>
</tr>
</tbody>
</table>

Figure 14: File-Export and File-Print Menus
Figure 15: Edit Menu
Figure 16: Database Menu
Figure 17: Database Menu: Point Database
Figure 18: Database Menu: Properties
Figure 19: Database Menu: Samples
Figure 20: Database Menu: Users
Figure 21: Help Menu
2.4.10 Non Logged-in Mode Menus

Before the user is logged in to the MSDTool database server and algorithmic framework, the user may only select to either: (1) “Login” or (2) “Exit” from the “File” menu. All other menus are disallowed.

2.4.11 Logged-in Mode Menus

Once the user has successfully logged-in, the application shall be in logged-in mode. Therewith, the application shall permit the end user full permission to operate in either the end-user persona or administrative-user persona depending on the respective account settings.

File  Figure 8 displays the file menu that becomes available after system users has logged-in.

   Logout  Logout permits the current user to return to the NON-LOGGED-IN mode.

   Import  Import (Figure 13) permits the current user to return to perform bulk-loads of PERSONAL MATERIAL DATABASES that were exported with MSDTool.

   Export  Export (Figure 14) permits the current user to export PERSONAL MATERIAL DATABASES to an XML file, and permits the user to export plots or visualizations windows to a rasterized graphics file.

   Print  Print (Figure 14) permits the current user to print any open plot or visualizations.

   Exit  Exit permits the user to leave the MSDTool, and will do so after committing any pending database operations.

Edit  A standard windows Edit Menu (Figure 15) allows the end user to edit any user mutable field as is inherited by the Windows User Interface Guidelines; additionally, the user will be able to copy the current open visualizations to the clipboard.

Database  The Database menu (Figure 16) permits the user to mutate settings in the MSDTool database.

   Point Database  Point Database (Figure 19) permits the user to add new point sets from which closures will be computed.

   Samples  Samples (Figure 19) permits the user to add new material samples.

   Users  User (Figure 20) permits administrative users to add accounts, and modify existing users. If the user has no permission to do so, this menu will be grayed-out.
Help  Online documentation can be requested through the help menu (Figure 21).

2.5  Database

The system provides:

2.5.1  Database Personas

To accommodate the ability to collaborate yet assure the ability for works in progress from being publicly accessible, the following database personas are defined:

1. Installation wide material databases
   The contents of known materials that all users use.

2. Lab wide material databases
   Databases belonging to a particular lab; wherein, users share materials in a lab, but not all system users may access the lab’s material.

3. Group Databases
   Databases owned by a given set of users. The system assumes no among users in the group.

4. Personal Databases
   Databases that are owned and accessible only by a single owner.

2.5.2  Material Closures

Each database persona may (1) add, (2) remove and (3) modify both materials and properties about materials

3  Non-Functional Requirements

3.1  Documentation

The following subsections enumerate the software documentation artifacts that the system produces.

3.1.1  User Manual

MSDTool will produce a documentation artifact that describes the program use from the end-user persona.

3.1.2  Design Document

MSDTool will produce a document description of how MSDTool realized its requirements.
3.1.3 API Reference

An API, to allow new algorithms to the system.

3.1.4 Maintainability

The system shall only require at most five hours of training to learn how to expertly administer.

3.2 Minimal Hardware Recommendations

The minimal hardware configuration recommendations inherit from the minimal hardware configuration recommendations.NET framework on a Windows XP machine with Service Pack 2.

3.3 Software Platform

MSDTool inherits the minimal set of existing software required by using the .NET software framework.

3.4 Decoupling Algorithms from Problems

Whereas the MMG defines the general class of algorithms as “optimization” routines that find a path among high-dimensional points that lie within the microstructure-hull, the system must not make any assumptions regarding the use of a given algorithm.

3.4.1 Unit Tests for Algorithms

Whereas the MMG defines the general class of algorithms as “optimization” routines that find a path among high-dimensional points that lie within the microstructure-hull, the system automatically validates the correctness of both existing and future algorithms that perform this task.

3.5 Run-time Speed and Expectations

All algorithms considered for use in the system must run within no-more-than ten seconds.

3.6 Network Interoperability

Whereas researchers and practitioners perform materials science and engineering research cooperatively among research institutions, the system facilitates the sharing of both (1) new algorithms and (2) new materials; and, whereas inter-system networking allows this level of collaboration; our system provides for network facilities for accomplishing both (1) and (2).
3.6.1 Properties Framework

MSDTool provides the ability through which new techniques may be added to the system as the MSD group, other outside stakeholders, and other third-parties advance the development of new properties and analysis techniques that are answer design questions.

3.6.2 Closures

Whereas closures are generally computationally expensive to compute interactively, the properties framework permits the ability to populate material closures for new techniques as they are developed.

3.6.3 Interactive

Whereas some of the same feature extraction code needs to be run interactively, the properties framework must allow for new techniques to be included in the interactive execution of the framework.

3.7 System Administration Requirements

3.7.1 Authentication

The system shall accept as authentication tokens a pair consisting of a user name and a password. An internal (i.e., by a user database inside the program) or an external ((e.g., LDAP ) mechanism processes the users’ authentication authorization

3.7.2 Adding Users

The system permits the adding of users to a local authentication database.

3.7.3 Groups of Users

The system permits the defining and modification of user groups to a local authentication database.

3.7.4 Deleting Users

The system permits the adding of users to a local authentication database.

3.7.5 Logging and Auditing

All operations that involve mutable operations upon the database are loggable at the behest of the system administrator.
# 4 Glossary

## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Application Program Interface. The system provides a public software interface, through which one may interact with an existing software artifact and extend it.</td>
</tr>
<tr>
<td>Authentication Tokens</td>
<td>A device, either virtual or physical, that permit the system to distinguish different users and restrict unauthorized use.</td>
</tr>
<tr>
<td>Data Ingress</td>
<td>The process of obtaining data into the system from the three different microstructural analysis techniques.</td>
</tr>
<tr>
<td>database persona</td>
<td>Descriptions that are given different modes of database use.</td>
</tr>
<tr>
<td>LDAP</td>
<td>Light-Weight Directory Access Protocol.</td>
</tr>
<tr>
<td>Microstructure</td>
<td>The observed structure of a metal or an alloy after the processes of etching and polishing under a high degree of magnification.</td>
</tr>
<tr>
<td>Nanoindentation</td>
<td>An destructive mechanical structure analysis technique, whereby an indenter collects load displacement values on geometries on the order of $1\text{nm}$.</td>
</tr>
<tr>
<td>Orientation Imaging Microscopy (OIM)</td>
<td>OIM determines the crystallographic orientation information about a sample material.</td>
</tr>
<tr>
<td>Raman Spectroscopy</td>
<td>A spectroscopic technique used in condensed matter physics and chemistry to study the vibrational, rotational, and other low-frequency modes in a system. This technique determines the chemical composition of materials.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>The party invested in the continued operation of the system for a community of end-users.</td>
</tr>
</tbody>
</table>
5 Index
Index

API, 30
application, 4
authentication tokens, 31
automation, 3

C (Programming Language), 3
commercial viability, 3
Core Algorithms, 5
custom materials, 4
database persona, 29
designers, 4
Drexel University, 2

Fortran, 3
Functional Requirements, 4

graphical user interface, 3
Group Databases, 29

Installation wide material databases, 29

Lab wide material databases, 29
LDAP, 31

Matlab, 3
Mechanics of Microstructure, 2, 5
modalities of interaction, 3

OIM, 4

Personal Databases, 29

Raman Spectroscopy, 4

space of properties, 4
system administrator, 31
tool-chain, 3
user interface, 3

Visual Basic, 3